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File Menu 
In the File menu are commands to print a disk space usage report and to exit WinDirUsage.
Print...
Exit



File|Print...
The File|Print... command is used to print a disk space usage report for the currently selected disk
and directory.    The information presented in the report is determined by the settings in the 
Printing...dialog box. 
Before the report is printed, you will be presented with a dialog for selecting a target printer and 
for configuring printer options.    The report may be printed to a file. 



File|Exit 
The File|Exit command is used to close WinDirUsage.    The size and position of the main 
window are not saved on exit (see Save Windows Position!). 



Rescan Menu 
Drives
The Rescan|Drives command is used to refresh the drives list.    Its primarily used when 
connecting to, or disconnecting from, network drives. 
Disk
The Rescan|Disk command re-reads the entire drive.    Its an alternate way to re-read the current 
drive instead of re-selecting it in the drive list. 
Directory
The Rescan|Directory command only re-reads the currently selected directory on the current 
drive.    Its useful when you'd like to see the effects of adding or deleting files in a given directory
tree, but would rather not re-read the entire drive. 



Options Menu 
The commands in the Options menu are used to configure the behavior and appearance of 
WinDirUsage.    All modified options are saved to WINDIRU.INI immediately.

Labeling...
Font...
Printing...
Save Windows Position!



Options|Labeling... 
The Labeling dialog box is used to configure how the information is presented in the main 
WinDirUsage window.    The size of the chart will change to adjust to different labeling options. 
Unless mentioned otherwise, options take effect immediately when the 'OK' button is pressed.    
Also see Button Behavior.

Label Pie Segments: Toggle this button off if you don't want pie segment labels. 

Segment Labels In: You may display pie segment labels in percentage, kilobytes, or 
megabytes. Percentage is rounded up to the nearest percent, kilobytes and megabytes are 
rounded up to one decimal point. 

Free Disk Space In: Free disk space may be in bytes, kilobytes or megabytes.    Kilobytes 
and megabytes are rounded up to two decimal points. 

Show Free Disk Space in Chart: Selecting this option will cause the drive free space to be
shown in the chart.    This option does not take effect until the next time the disk contents are 
read.    When the chart is labeled in percentage, this option changes the labels from percent of 
used disk space to percent of total disk space. 

Root Directory Label/Parent Directory Label: Three choices are provided for the 
directory list box entries representing the root and the parent directories. 

Indicate Expandable Branches: When this option is on, directories which have 
subdirectories will be shown in the directory list with a leading plus sign.    Also, when clicking 
on a directory that does not have subdirectories, the file display is shown immediately (see 
Viewing File Names).

Use Lowercase File Names: Selecting this option causes directory and file names to be 
shown in lowercase. This option doesn't take effect until the next time the disk contents are read. 

Bar Chart for Directories: Selecting this option causes the directory chart to be shown as a
bar chart.    The default is a pie chart.

Bar Chart for Files: Selecting this option causes the files chart to be shown as a bar chart.    
The default is a pie chart.

Show Allocated File Space: Using this option causes space calculations to be performed 
using the actual disk space allocated for files (i.e. taking disk cluster size into account).    This 
option does not take effect until the next disk read.

Read Disk at Startup: Disabling this option prevents the initial read of the disk from 
happening when WinDirUsage is started.    You may then select any disk to be read.    This option 
is only available with the 32-bit version.



Options|Font... 
The Options|Font... command invokes a standard Windows font selection dialog box.    The font 
you select here will be used by WinDirUsage to display the contents of its main window and the 
file display. 
Any of the listed font types or sizes may be selected, but some information may not be displayed 
properly using some types or sizes.    See Restrictions.



Options|Printing... 
The Printing dialog box is used to configure how the information is presented in the printed 
WinDirUsage disk usage report.    Also see Button Behavior..
Show Largest Directory Trees: This option currently has no effect. 
Show Largest File in Each Tree: Toggling this option on will cause the name and size of the 
largest file in each directory tree to be printed in the report. 
Limit Display by: Use this option to limit how many directories are displayed in the report. You 
may use either a count limit (all directories or a specified number) or a specified percentage 
limit. 



Dialog Buttons Behavior 
OK
Press this button to accept the selected options.    The options will be written to WINDIRU.INI 
immediately. 
CANCEL
Press this button to not accept the selected options. 
RESET
Press this button to reset the dialog box to the options selected when entering the dialog box.    
Useful if you've changed a large number of options and want to start over, without using 
CANCEL. 
DEFAULTS
Press this button to reset the dialog box to the original, "factory-installed" option settings. 



Options|Save Windows Position! 
The Options|Save Windows Position! command saves the current size and position of the 
WinDirUsage main window to WINDIRU.INI.    The current placement and size of the files 
dialog is also saved.



Specifying a Drive on the Command Line 
When WinDirUsage finds a drive letter in the command line, it will read that drive when it starts 
instead of the drive WinDirUsage was started from.    For example: 

C:\WINDOWS\WINDRU5.EXE    E: 
The above command line will cause WinDirUsage to read drive E: when it starts, rather than its 
default, drive C:.    Your default drive will depend on where WinDirUsage is located on your 
system. 
You may use a drive letter in the command line with either the File | Run... command under the 
File Manager or Program Manager.    Also, you can modify the command line in the Properties 
dialog box when creating a WinDirUsage icon for the Program Manager or a Windows 95 
shortcut.
You may wish to create multiple WinDirUsage icons or shortcuts, one for each drive on your 
system. WinDirUsage also provides different icons which you may select to display, indicating 
which drive will be read on startup. 
Note that if the "Read Disk at Startup" option is not checked, WinDirUsage will not actually read
the disk specified on the command line, but will select the specified disk as the starting disk.



Using WinDirUsage
Click on the area in the diagram below that you'd like more information about. 



Changing the Size of Windows
The WinDirUsage main window and file display window may be resized like many other 
windows, although they may not be sized any smaller than their original size.
If you size the window only along the horizontal axis, the chart will stay the same size, but the 
list boxes will expand horizontally.    If you size the window only along the vertical axis, the 
chart will expand vertically and horizontally, possibly at the expense of the list box's horizontal 
dimensions.
The position and size of the windows are not saved automatically. See Save Windows Position!.



Viewing File Names 
WinDirUsage provides a Files display, with a chart showing the files in a directory sorted by 
size. 
To view the Files display, select a <files> entry in the directory list. The Files display will pop up
in front of the WinDirUsage main window. When you're done viewing the Files display, click on 
the OK button. 
When the Show Expandable Branches option is selected (see Labeling), selecting a directory in
the list box that does not have any subdirectories will show the Files display for the selected 
directory. 
The files display may be resized in order to see more files in the chart.    However, the file list 
will not increase in size.



Viewing Just-mounted Drives 
WinDirUsage does not automatically detect when you connect to a new network drive.    You 
must use the Rescan command to update the WinDirUsage drive list so that you can access the 
newly connected network drive. 



WinDirUsage V1.5c Registration Information
You may register a shareware copy of WinDirUsage V1.5c by contacting Laser Point. A single 
license for WinDirUsage costs $20 (US).
To register, you must have the Code for Laser Point from the Registration dialog box. To get to 
the dialog box, use the Register entry in the Help menu. You cannot register without this code! 
Laser Point will provide you with a registration key which you enter in the Registration dialog 
to register your copy of WinDirUsage.
To obtain technical support, please see Technical Support. The contact information to Laser 
Point is for orders only!

Order by Phone:
Visa and Mastercard orders may be placed by calling: 

800-894-6758 or 408-722-6894
You will be asked for the Code for Laser Point, so have it ready!

Order by Email / FAX:
To register by email, send this info to orders@laserpoint.com, or Fax to 408-772-6895:

1. Specify that you are ordering WinDirUsage
2. Visa or Mastercard account number, also indicate the type of card!
3. Card Expiration date
4. Name of card holder
5. Address to ship to
6. Include the Code for Laser Point from the Registration dialog.

See Also:
Ordering via Postal Mail
Ordering via Compuserve
Multi-User Licenses



More Ways to Register WinDirUsage!

Order by Postal Mail:
Send cash or checks, drawn in U.S. funds on a U.S. bank, to:

Laser Point
WinDirUsage Registration
P.O. Box 2378
Watsonville, CA    95077

California residents must include 8.25% sales tax [orders will be returned if not included!] For 
orders from outside the U.S., please include $2.00 for shipping.    Dont forget the Code for Laser
Point! You will be sent your registration key.

Order via Compuserve
Compuserve customers may wish to use the Compuserve Shareware Registry. GO SWREG and 
register product #13206.
You will be contacted by Laser Point for the Code for Laser Point, and then provided with your 
registration key.

Multi-User Licenses:
The following discounts are available for multi-user license orders:
up to 5 Users: $75 (US) (save 25%!)
up to 10 Users: $140 (US) (save 30%!)
up to 25 Users: $325 (US) (save 35%!)
Order the same as for a single license, but indicate how many users you are ordering for. If you 
wish to order more than 25 licenses, please contact Laser Point to discuss pricing. You will need 
to provide the Code for Laser Point for each machine WinDirUsage will be installed upon; for 
alternate licensing, please contact Laser Point.



WinDirUsage V1.5 Restrictions
The known problems and restrictions in WinDirUsage V1.5: 
The mouse is required to use WinDirUsage, the keyboard is not supported. 
WinDirUsage will read recursive disk pointers until memory is exhausted.    This is primarily a 
problem with corrupt MS-DOS disk structures and with OpenVMS [000000] directories. 
Switching the case of file names and displaying free disk space as a pie slice do not take effect 
until the next drive read. 
In directories containing a large number of small files, the Files display may not show a pie 
chart. 
Attempting to read a disconnected network drive will cause WinDirUsage to display incorrect 
information about the drive. 
Chart labels may be truncated with TrueType or italic fonts.    It may be necessary to tweak the 
size of the main window before WinDirUsage properly adjusts the sizes of objects to a newly 
selected font. 
Options set by one WinDirUsage window will not be picked up by another WinDirUsage 
window running at the same time. 
Its not possible to have two different file displays at the same time from the single WinDirUsage 
window. 
The <free space> entry in the chart does not update until the next read of the disk.    As a result, it
may not be in agreement with the free space display at the bottom of the main window, which 
updates every time the main window is redrawn. 
Display of a disk with nothing but empty directories is not correct, especially using the Show 
Allocated Space option.



Installation and De-Installation
You most likely received your evaluation copy of WinDirUsage as a .ZIP file.    To install, 
unpack the .ZIP file into a directory on your hard disk. WINDRU5.HLP and NTHELPR.EXE 
must be in the same directory as the executables, otherwise WinDirUsage will refuse to run. The 
other files are not needed after you've read them and ordered your registered copy.
WIND165.EXE/WIND325.EXE may be executed using the File|Run... command from either 
Program Manager or File Manager.    You may wish to create an icon in Program Manager for 
convenient execution, or a shortcut on your desktop. 
De-Installation 
Should you choose not to keep WinDirUsage, it may be de-installed by deleting the files you 
restored from the distribution set.    Also, delete any Program Manager groups and/or icons you 
may have created.    Finally, delete WINDIRU.INI from your Windows directory.    That's it! 



Preventing Constant Disk Reads 
It is a restriction in evaluation copies of WinDirUsage that every directory selection will cause 
the disk to be read again.    A disk read will also happen when invoking dialog boxes.    Any such 
unnecessary disk read is identified as such in the WinDirUsage Status dialog box.
A registered copy of WinDirUsage will not perform these unnecessary disk reads, nor will the 
initial Evaluation notice dialog box appear.    See How to Register.



The list box contains the names of the subdirectories in the currently selected directory.    Click 
on an entry to move to a subdirectory. <files> will show the files dialog for the current directory. 
The Root Directory entry will move back to the disk root, and Parent Directory moves up one 
level in the directory tree.    Entries with a white box are directories too small to be displayed in 
the pie chart. 



The drive selection list is used to select the drive to be displayed. 



The pie chart shows space information for the current drive and directory.    You can move to a 
subdirectory by clicking on its pie slice or its entry in the list box. 



The currently selected drive and directory are shown here. 



The size of the currently selected directory and all its subdirectories is shown here. 



The currently selected drive, its volume name, and the amount of free space on the drive are 
shown here. 



New Features in V1.5c
 Native 32-Bit for Windows 95, Windows NT.
 Support for long filenames under Windows 95 and Windows NT.
 New option: display allocated file size.
 New option: display using a bar chart.
 Ability to resize the file display window.
 Handles missing removable media (e.g. reading an empty floppy drive).
 Miscellaneous bug fixes.
 New option: Prevent initial disk scan



Obtaining Technical Support
If you have any problems, questions, or suggestions regarding WinDirUsage, you can get 
Technical support by contacting Laser Point at:

Voice: 408-772-6894
Fax: 408-772-6895
Email: windirusage@laserpoint.com

Please be prepared to provide a full description of the problem, the configuration of your PC and 
network, and any other information which may be pertinent to the problem.




